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CALIBRATION PROCEDURE

SCXI™-1125

For NI-DAQ™mx

This document contains information and instructions for calibrating the
National Instruments SCXI-1125 signal conditioning module.
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Conventions

The following conventions are used in this document:

» The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

@ Note This icon denotes a note, which alerts you to important information.
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bold

italic

monospace

monospace italic

Software

Bold text denotes items that you must select or click in the software, such
as menu items and dialog box options. Bold text also denotes parameter
names.

Italic text denotes variables, emphasis, a cross-reference, or an introduction
to a key concept. Italic text also denotes text that is a placeholder for a word
or value that you must supply.

Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames, and extensions.

Ttalic text in this font denotes text that is a placeholder for a word or value
that you must supply.

The SCXI-1125 calibration procedure requires the NI-DAQmx driver.

NI recommends using the latest driver that supports both your development
environment and the SCXI-1125. NI-DAQmx includes high-level function
calls to simplify the task of writing software to calibrate devices.
NI-DAQmx supports many programming languages, including LabVIEW,
LabWindows"™/CVI™, C/C++, C#, and Visual Basic .NET.

Documentation

SCXI-1125 Calibration Procedure

The following documents are the primary references for writing your
calibration utility:

e The NI-DAQmx Help includes information about creating applications
that use NI-DAQmx.

e The NI-DAQmx C Reference Help includes information about the
functions in NI-DAQmx.

*  The DAQ Getting Started guides include information about installing
and configuring NI-DAQ devices.

You can access these documents by selecting Start»All Programs»
National Instruments»NI-DAQmx after installing NI-DAQmx.

For more information about the SCXI-1125, refer to the SCXI-1125 User
Manual. For information about installing and configuring SCXI modules,
refer to the SCXI Quick Start Guide.
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Calibration Interval

Calibrate the SCXI-1125 at a regular interval as defined by the
measurement accuracy requirements of your application. NI recommends
that you perform a complete calibration at least once every year. You can
shorten this interval based on the accuracy requirements of your
application.

Password

The default password for password-protected operations is NT.

Test Equipment

NI recommends that you use the equipment in Table 1 to calibrate the
SCXI-1125. If these instruments are not available, use the requirements

listed in Table 1 to select a suitable substitute.

Table 1. Test Equipment

Equipment Recommended Model Requirements
Calibrator Fluke 5700A 50 ppm
DAQ Device NI 6281 16-bit minimum

DMM

NI 4070 or Agilent 34401A

6 1/2 digit, 15 ppm

Terminal Block

SCXI-1320

Test Conditions

Follow these guidelines to optimize the connections and the environment
during calibration:
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Keep connections to the SCXI-1125 as short as possible. Long cables
and wires can act as antennas, picking up extra noise and thermal

offsets that affect measurements.

Use shielded copper wire for all cable connections to the SCXI-1125.
Use twisted-pair wire to eliminate noise and thermal offsets.

Maintain the ambient temperature between 18 °C and 28 °C.

Keep relative humidity below 80%.

Allow a warm-up time of at least 15 minutes for the SCXI-1125 and
30 minutes for the DAQ device to ensure that the measurement
circuitry is at a stable operating temperature.

SCXI-1125 Calibration Procedure



Calibration Process

Initial Setup

SCXI-1125 Calibration Procedure

The calibration process has the following steps:

1.
2.

Initial Setup—Configure the SCXI-1125 for calibration.

Verification Procedure—Verify the existing operation of the
SCXI-1125. This step determines whether the SCXI-1125 is operating
within its test limits.

Adjustment Procedure—Perform an external calibration that adjusts
the SCXI-1125 calibration constants with respect to a known voltage
source.

Verifying Adjusted Values—Perform another verification to ensure
that the SCXI-1125 is operating within its test limits after adjustments.

Complete the following steps to configure the SCXI-1125 for calibration:

1.

Make sure that all the appropriate driver and application software is
installed.

Make sure all components involved in the calibration procedure are
powered off.
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3. Assemble the SCXI-1125, SCXI chassis, terminal blocks, and DAQ
device as shown in Figure . You must cable the SCXI-1125 directly to
the DAQ device.

1 SCXI-1320 Terminal Block 7 CB-50 Connector Block
2 SCXI-1125 Module 8 Cable to DMM

3 SCXI Chassis 9 Cable to Calibrator

4 SCXI-1349 Cable Adapter 10 Calibrator

5 Shielded 68-Pin Cable 11 DMM

6 NB1 Cable (50-Pin Ribbon Cable) 12 DAQ Device

Figure 1. Calibration Connections
Power on the SCXI chassis and the external computer.

You must configure the hardware properly with Measurement &
Automation Explorer (MAX). Refer to the SCXI Quick Start Guide for
details about configuring the SCXI chassis.

@ Note When you configure a device in MAX, the device is assigned a device identifier. In
this calibration document, the functions used for demonstrating the calibration process use
the device identifiers Dev1 for the DAQ device and SCc1Mod1 for the SCXI-1125.
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Verification Procedure

SCXI-1125 Calibration Procedure

The verification procedure determines how well the SCXI-1125 is meeting
its test limits. You can use this information to select the appropriate
calibration interval for your application.

The SCXI-1125 stores gain and offset calibration constants for each gain
setting per analog input channel. A complete verification of the inputs
involves measuring the accuracy at all possible gain settings on all channels
of the SCXI-1125.

To view the calibration VIs in LabVIEW, select Measurement I/O»
DAQmx - Data Acquisition>DAQmx Advanced»DAQmx Calibration
on the Functions palette. You can also use the Search button, shown in
Figure , to look for a specific VL.

—

Search MG Wiew ™

|"'» " Programming

¥  Measurement IO
L D&y - Daka dcquisition
L DA Advanced
L Dwan Calibratian

DA Calibration

i

42 Calibration  SCxI Calibration

£

Figure 2. DAQmx Calibration Palette and the Search Button
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Complete the following steps to verify the accuracy of each SCXI-1125

analog input channel:

1. Use the DAQmx Self Calibrate VI to verify the DAQ device. This VI
measures the onboard reference voltage of the DAQ device and adjusts
the self-calibration constants to account for any errors caused by
short-term fluctuations in the operating environment.

Note Throughout the verification procedure, refer to the function call parameters for the

LabVIEW input values.
LabVIEW Block Diagram NI-DAQmx Function Call
Call bAQmxSelfcal with the following
device in DA Self

Calibrate, vi

error ouk

parameter:

deviceName: "Dev1"

2. Connect the calibrator output to pins Al- and Al+ for all channels.
Refer to the SCXI-1320 High-Voltage Terminal Block Installation
Guide and Specifications for connection instructions. If you are not
using the recommended SCXI-1320, refer to Table 4 for the front
signal pin assignments of the SCXI-1125. If the calibration signal
source is floating, connect Al- to the SCXI chassis ground using the
ground lug available on the SCXI terminal block.

3. Set the calibrator voltage to the desired test point indicated in Table 2.

4. Create a task using DAQmxCreateTask.

LabVIEW Block Diagram

NI-DAQmx Function Call

LabVIEW does not require this step.

Call DAQmxCreateTask with the following
parameters:

taskName: "AIVerificationTask"

taskHandle: staskHandle

© National Instruments Corporation
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5. Add a voltage channel using the DAQmx Create Virtual Channel VI.

LabVIEW Block

Diagram

NI-DAQmx Function Call

minimum walue
[}

mazimum value
* DAz

physical channels

Al Yolkage

wirtual Channel,vi

reate

=% bask out

= Brrar auk

Call DAQmxCreateAIVoltageChan with the
following parameters:

taskHandle: taskHandle

physicalChannel: "sc1Modl/aix"t
nameToAssignToChannel: "myVoltageChannel"
terminalConfig: DAQmx_Val_Cfg_Default
minVal: -5V

maxVval: 5V

units: DAQmx_Val_Volts

customScaleName: " "

fWhere X refers to the channel you are verifying.

6. Setthe SCXI-1

125 to a gain setting that corresponds to the current test

point in Table 2 using the DAQmx Channel Property Node. You can
find the AI.Gain property by selecting Analog Input»General
Properties»Advanced»Gain.

LabVIEW Block Diagram

NI-DAQmx Function Call

Property Node

baskin 23 el & =2 Dagm:x Channel gm;};; task out
Brrrin = r S EfTor out
AT.Gain

k

Call DAQmxSetAIGain with the following
parameters:

taskHandle: taskHandle
channel: "

data: (gain value for particular test
point) float64

SCXI-1125 Calibration Procedure
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7. Configure timing for the voltage acquisition using the DAQmx

Timing VI
LabVIEW Block Diagram NI-DAQmx Function Call

Call DAQmxCfgSampClkTiming with the following

samples per channel parameters:

rate taskHandle: taskHandle

1000

D TR
Tirming.vi source:

taskin == T = kask out
rate: 1000.0

EFTOF M 5 s =% error ouk

Sample Clock activeEdge: DAQmx_val_Rising
sampleMode: DAQmx_Val_FiniteSamps
sampsPerChanToAcquire: 1000
8. Commit the verification changes using the DAQmx Control Task VI.
LabVIEW Block Diagram NI-DAQmx Function Call
Call DAQmxTaskControl with the following
ackion
DA parameters:
Control

Task. vi

= task out

ErTar in = oo LAY oo = errar oukt

taskHandle: taskHandle

action: DAQmx_Val_ Task_Commit

9. For each new test point, use the Time Delay Express VI to account for

the 5 second settling time.

LabVIEW Block Diagram

Function Call

Delay Time (s}
v Time Delay

errorin == =====J E L===>> errar ouk

Delay Time: 5

© National Instruments Corporation
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10. Acquire 1000 points of voltage data using the Analog 1D DBL 1Chan
NSamp instance of the DAQmx Read VI.

LabVIEW Block Diagram NI-DAQmx Function Call
Call bAQmxReadAnalogF64 with the following
parameters:
it taskHandle: taskHandle
ata
! numSampsPerChan: -1
Danx_
taskin »x -——-«T%w > taskout timeout: 10.0
55
srrorin == DL b 3> gprar auk fillMode: DAQmx_Val_GroupByChannel

#Analog 10 DBL
l:lc"a“ Moamp | readArray: data
arraySizeInSamples: 1000

sampsPerChanRead: sread

reserved: NULL

11. Compute the mean of the 1000 voltage values that you acquired.

12. Compare the resulting average to the upper and lower limits listed in
Table 2. If the result is between the upper and lower limits, the
SCXI-1125 passes the test.

13. Clear the acquisition using the DAQmx Clear Task VI.

LabVIEW Block Diagram NI-DAQmx Function Call
DAGX Clear Call DAQm?x:ClearTask with
Task, vi the following parameter:

taskin == [

error ouk

error in s = | taskHandle: taskHandle

14. Repeat steps 4 through 13 for the remaining channels.
15. Repeat steps 3 through 14 for all test points in Table 2.

You have finished verifying the analog input accuracy of the SCXI-1125.

Adjustment Procedure

The adjustment procedure adjusts the gain and offset calibration constants
on the SCXI-1125. Complete the Verification Procedure prior to the
adjustment procedure to determine the pre-calibration accuracy and
whether adjustments are necessary.

SCXI-1125 Calibration Procedure 10 ni.com



Complete the following steps to adjust the gain and offset of the

SCXI-1125:

1. Connect the DMM to AO 0+ and AO 0- (pin 3 and 4) on the rear
connector. Refer to Table 5 for rear signal pin assignments of the

SCXI-1125.

5

Note You can access these pins using a 50-pin cable connected to an SCXI-1349.

2. Connect the calibration output to pins Al- and Al+ for all channels.
Refer to the SCXI-1320 High-Voltage Terminal Block Installation
Guide and Specifications for connection instructions. If you are not
using the recommended SCXI-1320, refer to Table 4 for the front
signal pin assignments of the SCXI-1125. If the calibration signal
source is floating, connect Al- to the SCXI chassis ground using the
ground lug available on the SCXI terminal block.

3. Start an external calibration session using the DAQmx Initialize
External Calibration VI.

Note Throughout the adjustment procedure, refer to the function call parameters for the

LabVIEW input values.

LabVIEW Block Diagram

NI-DAQmx Function Call

DaAQm:: Initialize

device in

+= talhandle out

=2 error out

Call DAQmxInitExtCal with the following
parameters:

deviceName: "SC1Modl"
password: "NI"

calHandle: scalHandle

4.  Set the SCXI-1125 to a gain value listed in Table 3 using the DAQmx
Setup SCXT Calibration VI.

LabVIEW Block Diagram

NI-DAQmx Function Call

phsical channel

DA Setup
S Calibration, vi

cahandle in == -| == calhandle out

BFFOF N > s e = > EFFOF QUE

1125

Call DAQmxSetupl125Cal with the following
parameters:

calHandle: calHandle
channelNames: "sCc1Modl/aix"t

gain: (gain value found in Table 3)
float64

TWhere X refers to the channel you are calibrating.

© National Instruments Corporation
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5. Set the calibrator to a set point for the gain value you set in step 4.
Refer to Table 3 for appropriate voltage set points.

6. Wait for 5 second settling time to elapse and then record the measured

output from the DMM.
7. Adjust the external calibration constants using the DAQmx Adjust
SCXI Calibration VI.
LabVIEW Block Diagram NI-DAQmx Function Call

Call pAQmxAdjust1125Cal with the
reference voltage R
] following parameters:

measured oukpuk
= " calHandle: calHandle
DA Adjust SCRI

Calibration, vi refVoltage: (calibrator output

handle in = —| == calhandl k
calhandle in —%‘Sﬁ calhandlé ol voltage) float64
ol

Brrorin = = error out
1125 = measOutput: (voltage measured by

DMM) float64d

8. Repeat steps 5 through 7 for all voltage set points at the current gain
value in Table 3.

9. Commit the calibration changes you made in the session using the
DAQmx Close External Calibration VI. The data is written to the
hardware in this step.

LabVIEW Block Diagram NI-DAQmzx Function Call

Call DAQmxCloseExtCal with the following
parameters:

DMy Close External

Calibration, vi .

calhandle in == — n-.:n-. o calHandle: caliandle
. error out .
e o | action: DAQmx_Val_Action_Commit

10. Repeat steps 3 through 9 for all gain values in Table 3.
11. Repeat steps 2 through 10 for the remaining channels.

You have finished adjusting the gain and offset of the SCXI-1125.

Verifying Adjusted Values

After calibrating the SCXI-1125, NI recommends that you verify the
analog input operation by repeating the steps listed in the Verification
Procedure to ensure that the SCXI-1125 is operating within its test limits.

SCXI-1125 Calibration Procedure 12 ni.com



Test Limits

Refer to the SCXI-1125 User Manual for the specifications of the
SCXI-1125.

Gain and Offset

Table 2 contains the test limits to use when verifying the gain and offset of
the SCXI-1125. Table 3 contains the set points for the adjustment. If the
SCXI-1125 was calibrated within the last year, the test point value should
fall between the Lower Limit and Upper Limit values found in Table 2.

@ Note The values in Table 2 do not include DAQ device errors.

Table 2. Upper and Lower Limit Channel Settings

Gain Range Test Point Upper Limit (V) | Lower Limit (V)
1 5 4.950000 4.982047 4.917953
1 0 0.000000 0.006802 -0.006802
1 -5 -4.950000 -4.917953 -4.982047
2 25 2.475000 2.491123 2.458877
2 0 0.000000 0.003426 -0.003426
2 -2.5 -2.475000 -2.458877 -2.491123
5 1 0.990000 0.996498 0.983502
5 0 0.000000 0.0014 -0.0014
5 -1 -0.990000 -0.983502 -0.996498
10 0.5 0.495000 0.49825 0.49175
10 0 0.000000 0.000701 -0.000701
10 -0.5 -0.495000 -0.49175 -0.49825

20 0.25 0.247500 0.249139 0.245861
20 0 0.000000 0.000364 -0.000364
20 -0.25 -0.247500 -0.245861 -0.249139
50 0.1 0.099000 0.099669 0.098331
50 0 0.000000 0.000159 -0.000159

© National Instruments Corporation 13 SCXI-1125 Calibration Procedure



Table 2. Upper and Lower Limit Channel Settings (Continued)

Gain Range Test Point Upper Limit (V) | Lower Limit (V)
50 -0.1 -0.099000 -0.098331 -0.099669
100 0.05 0.0495000 0.049846 0.049154
100 0 0.000000 0.000091 -0.000091
100 -0.05 -0.049500 -0.049154 -0.049846
200 0.025 0.024750 0.024936 0.024564
200 0 0.000000 0.000058 -0.000058
200 -0.025 -0.024750 -0.024564 -0.024936
250 0.02 0.019800 0.019954 0.019646
250 0 0.000000 0.000051 -0.000051
250 -0.02 -0.019800 -0.019646 -0.019954
500 0.01 0.009900 0.009989 0.009811
500 0 0.000000 0.000038 -0.000038
500 -0.01 -0.009900 -0.009811 -0.009989
1000 0.005 0.00495 0.005007 0.004893
1000 0 0.000000 0.000031 -0.000031
1000 -0.005 -0.004950 -0.004893 -0.005007
2000 0.0025 0.002475 0.002515 0.002435
2000 0 0.000000 0.000027 -0.000027
2000 -0.0025 -0.002475 -0.002435 -0.002515

Limits valid for 4 Hz or 10 kHz filter settings.

Valid when using an MIO device after performing an MIO internal calibration.
Valid for both filter settings with 1,000 point averaging at 1,000 samples per second.

SCXI-1125 Calibration Procedure

14

ni.com




Table 3. Adjustment Set Points

Gain Set Points (V)
1 4.5 3 1.5 0 -1.5 -3 -4.5
2 2.25 1.5 0.75 0 -0.75 -1.5 -2.25
5 0.9 0.6 0.3 0 -0.3 -0.6 -0.9
10 0.45 0.3 0.15 0 -0.15 -0.3 -0.45
20 0.225 0.15 0.075 0 -0.075 -0.15 -0.225
50 0.09 0.06 0.03 0 -0.03 -0.06 -0.09
100 0.045 0.03 0.015 0 -0.015 -0.03 -0.045
200 0.0225 0.015 0.0075 0 -0.0075 -0.015 -0.0225
250 0.018 0.012 0.006 0 -0.006 -0.012 -0.018
500 0.009 0.006 0.003 0 -0.003 -0.006 -0.009
1000 0.0045 0.003 0.0015 0 -0.0015 -0.003 -0.0045
2000 0.00225 0.0015 0.00075 0 -0.00075 | -0.0015 | -0.00225

SCXI-1125 Front and Rear Panel Diagrams

Table 4 shows the pin assignments for the SCXI-1125 front panel
connector. Table 5 shows the pin assignments for the SCXI-1125 rear

signal connector.

© National Instruments Corporation
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Table 4. Front Signal Pin Assignments

Front Connector Diagram Pin Number Column A Column B Column C
32 ALO + — AT 0-
Column 31 _ _ _
A B C
—_— 30 ALl + — Al 1-
32 | o o 29 — — —
31
28 NC — NC
30 o o
29 27 — — -
28 o o 26 Al2 + — Al 2-
27 25 _ _ _
26 © © 24 Al3 + — Al 3-
25
24 | o o 23 - — —
23 22 NC — NC
22 | © ° 21 — — —
21 20 Ald+ — Al4-
20 o o
19 — — _
19
18 | o ° 18 AIS+ — AIS-
17 17 — — —
16 | © ° 16 NC — NC
15 15 . . —
14 o o
13 14 Al 6 + — Al 6-
12 | o o 13 — — —
11 12 Al7 + — Al 7-
10 | o o 1 — — —
9
10 NC — NC
8 o o
7 ? — — -
6 o o 8 RSVD — RSVD
5 7 _ _ _
4 o o
6 RSVD — RSVD
3
2 | o o 3 - - -
1 4 +5V — CJ TEMP
IE—
3 — — _
RSVD—Reserved 2 CHS GND - RSVD
NC—no connection
— 1o pin 1 — — —
SCXI-1125 Calibration Procedure 16 ni.com



Table 5. Rear Signal Pin Assignments

Rear Connector

Diagram Signal Name Pin Number Pin Number Signal Name
AO GND 1 2 AO GND
AO 0+ 3 4 AO 0-
AO 1+ 5 6 AO 1-
1|2 AO2+ 7 8 AO 2-
3|4 AO3 + 9 10 AO 3-
5|6
7 8 AO4 + 11 12 AO 4-
9|10 AO S + 13 14 AO 5-
11112 AO 6 + 15 16 AO 6-
13|14
15|16 AO 7+ 17 18 AO 7-
17118 OUT REF 19 20 -
19120
21|22 - 21 22 -
23|24 — 23 24 D GND
25]26 SER DAT IN 25 26 SER DAT OUT
27|28
29|30 DAQ D*/A 27 28 —
8132 SLOT 0 SEL* 29 30 —
33|34
35| 36 — 31 32 —
3738 D GND 33 34 —
39| 40
41| 42 — 35 36 AT HOLD COMP, Al HOLD
43 | 44 SER CLK 37 38 —
45| 46 . 29 40 -
47| 48
49 | 50 — 41 42 —
— 43 44 —
— 45 46 SYNC
— 47 48 —
— 49 50 —
© National Instruments Corporation 17 SCXI-1125 Calibration Procedure



World Wide Support and Services

The National Instruments website is your complete resource for technical
support. At ni.com/support you have access to everything from
troubleshooting and application development self-help resources to email
and phone assistance from NI Application Engineers.

Visit ni.com/services for NI Factory Installation Services, repairs,
extended warranty, and other services.

Visit ni.com/register to register your National Instruments product.
Product registration facilitates technical support and ensures that you
receive important information updates from NI.

National Instruments corporate headquarters is located at 11500 North
Mopac Expressway, Austin, Texas, 78759-3504. National Instruments also
has offices located around the world. For telephone support in the United
States, create your service request at ni . com/support or dial

1 866 ASK MYNI (275 6964). For telephone support outside the United
States, visit the Worldwide Offices section of ni.com/niglobal to access
the branch office websites, which provide up-to-date contact information,
support phone numbers, email addresses, and current events.

Refer to the N/ Trad ks and Logo Guidelines at ni . com/ trademarks for more information on NI trademarks. Other product and company names mentioned herein
are trademarks or trade names of their respective companies. For patents covering NI products/technology, refer to the appropriate location: Help»Patents in your software,
the patents. txt file on your media, or the National Instruments Patents Notice at ni . com/patents. You can find information about end-user license agreements
(EULAs) and third-party legal notices in the readme file for your NI product. Refer to the Export Compliance Information at ni . com/legal/export-compliance
for the NI global trade compliance policy and how to obtain relevant HTS codes, ECCNs, and other import/export data. NI MAKES NO EXPRESS OR IMPLIED WARRANTIES
AS TO THE ACCURACY OF THE INFORMATION CONTAINED HEREIN AND SHALL NOT BE LIABLE FOR ANY ERRORS. U.S. Government Customers: The data contained in
this manual was developed at private expense and is subject to the applicable limited rights and restricted data rights as set forth in FAR 52.227-14, DFAR 252.227-7014,
and DFAR 252.227-7015.

© 2000-2015 National Instruments. All rights reserved. 370271B-01 Oct15
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